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	  SEQ CHAPTER \h \r 1Chapter

1
	Introduction to 

Fabrikam, Inc.


SOFTWARE OBJECTIVES XE "SOFTWARE OBJECTIVES" :  In Chapter 1, you use the software to:

1. Start Great Plains 8.0 (GP).

2. Explore the sample company, Fabrikam, Inc.
3. Set user preferences.
4. Operate Great Plains’s drop-down lists, lookup fields, toolbar, navigation pane, and menus.

5. Identify GP’s program path with Windows Explorer.
6. Unload or detach data.

7. Load or attach data.

8. Copy Fabrikam files.

9. Zip Fabrikam files.

10. Navigate the Help system.

WEB OBJECTIVES XE "WEB OBJECTIVES" :  In Chapter 1, you do these Internet XE "Internet"  activities:

1. Go online to Great Plains’s web site at www.microsoft.com/BusinessSolutions/GreatPlains
2. Use your Internet XE "Internet"  browser to go to the book’s web site at www.mhhe.com/yachtgreatplains.
3. Complete the Internet XE "Internet"  Activities.
Great Plains 8.0 (GP) is similar to other programs that use Windows. If you have used other Windows programs, specifically Microsoft Outlook, you will recognize the similarities. If you are not familiar with Windows, using GP will help you become familiar with the Windows operating system.

MOUSE AND KEYBOARD BASICS XE "MOUSE AND KEYBOARD BASICS" 
One of the first decisions you need to make is whether to use the mouse or keyboard. The instructions in this book assume that you are using a mouse. When the word click is used in the instructions, it means to use your mouse, but you can also use the keyboard.  

Using the Mouse XE "Using the Mouse" 
· To single click: position the mouse cursor over what you want to select and click the left mouse button once.
· To double-click: position the mouse cursor over your selection and click the left mouse button twice, quickly.
· Use the right mouse button the same way you use the left mouse button.
Using the Keyboard XE "Using the Keyboard" 
· Hold down the <Alt>
 key and the underlined letter to make the selection.
· If you have already held down the <Alt> key and the underlined letter and more selections appear with underlined letters, just type the underlined letter to select the item.

Using Shortcut Keys XE "Using Shortcut Keys" 
Shortcut keys XE "Shortcut keys"  enable you to perform common operations by using two or more keys together. 
	<Ctrl>+<Letter> Shortcuts

	<Ctrl>+<X>
	Cut

	<Ctrl>+<C>
	Copy

	<Ctrl>+<V>
	Paste

	<Ctrl>+<P>
	Print

	<Ctrl>+<F>
	Find 

	<Ctrl>+<A>
	Search All

	<Ctrl>+<Y>
	Analysis

	<Ctrl>+<L>
	Lookup XE "Lookup"  

	Function Key Shortcuts XE "Function Key Shortcuts" 

	<F1>
	Displays the online Help

	<Ctrl>+<F4>
	Closes the current window

	<Alt>+<F4>
	Closes the application

	<Ctrl>+<F6>
	Moves to the next window

	<Shift>+<Ctrl>+<F6>
	Moves to the previous window


GETTING STARTED XE "GETTING STARTED"  
Fabrikam, Inc. is the sample company included with GP. The purpose of using the sample company in Chapters 1-6 is to help you become familiar with the software. In Chapters 7-14, you use the software to work with service, merchandising, nonprofit, and manufacturing companies. 

To start Great Plains, do the following.
 
1. Double-click on the desktop icon for Great Plains Education (or, select, Start; All Programs, Microsoft Business Solutions, Great Plains-Education). The Welcome to Microsoft Business Solutions-Great Plains window appears. Type your password. (Your window may differ. For example, you may need to select greatplains in the Server field. Type your password, then continue with step 2.)
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2. Click [image: image1.png]


. The Company Login window appears.
3. In the Company field, select Fabrikam, Inc.
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4. Click [image: image2.png]


.
5. The Microsoft Business Solutions-Great Plains window appears saying you have chosen the sample company. Read the information.
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6. Click [image: image3.png]


.

7. The main window for Great Plains appears. Compare your window with the one shown on the next page. The callouts are explained in the Windows Graphical User Interface section on pages 7-9.
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Finding window information
Make sure the navigation pane of the help window is showing. (Clisk the Show button on the help toolbar, or choose Options
>> Show Tabs ) Select the Index or Search tabs, and search for the name of the window you are using, The window
overview topic describes what the window is used for, how to display the window, and provides links to topics describing
tasks you can perform in the window. Links are also provided to topics describing fields, buttons and menus for the window

ing field, button or menu information

Make sure the navigation pane of the help window is showing. (Click the Show button on the help toolbar, or choose Options
>> Show Tabs.) Select the Index or Search tabs, and search for the name of the window you are using. Display the window
averview topic, and click the Fields, Buttons ar Menus links at the tap of the topic. (The Menus link is available anly for
windows that have specific menus associated with them )

g task (procedure) information

Make sure the navigation pane of the help window is showing. (Click the Show buttan on the help toolbar, or choose Options
>> Show Tabs.) Select the Index tab, and search for the task you would like to perform. For tasks related to a particular
window, search for the window name, and select a task from those listed in the window overview topic. You can also browse
entries in the Contents tab for the madule you are using

inding message information

Make sure the navigation pane of the help window is showing. (Click the Show button on the help toolbar, or choose Options
>> Show Tabs.) Select the Search tab, enter all or part of the message, and dlick List Topics. Alternatively, select the
contents tab, and browse to the messages topic for the module you are using.

Symbols used in help
The following symbols are used to make specific types of information stand out

symbol | Description
@ “The light bulb symbol indicates helpful tips, shortcuts and suggestions
The warning symbol indicates situations you should be especially aware
A o
S The mouse symbal indicates information to guide you to the appropriate
location in the software



THE WINDOWS GRAPHICAL USER INTERFACE (GUI)
One of the benefits of Windows is that it standardizes terms and operations used in software programs. Once you learn how to move around in GP’s menus, you also know how to use other Windows applications.  

To learn more about the Windows environment, let's look at a GP window. The window illustration above shows the parts of the GP window as well as the menu bar for Fabrikam, Inc. Each time you make a menu bar selection, a list drops down.  Or, you can use the Navigation Pane XE "Navigation Pane"  and Series buttons XE "Series buttons"  to make selections. Both the Navigation Pane and Series buttons will be used in this textbook.
For now, let's study the parts of the window shown on page 7. Some features are common to all software programs that are written for Windows. For example, in the upper right corner is the Minimize [image: image4.bmp] button, Double Window [image: image5.bmp] button, and the Close [image: image6.bmp] button. The title bar, window border, and mouse pointer are also common to Windows programs.  Other features are specific to GP: menu bar, toolbar, and navigation pane.

Windows programs use menus in the form of horizontal menu bar selections. The contents of these menus differ depending on the application.  
The window illustration on page 7 is described on this page and page 9.
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Title Bar XE "Title Bar"   The bar is at the top of the window and shows Microsoft Business Solutions-Great Plains. Just below the title bar is the menu bar and name of the opened company.

( 
Menu Bar XE "Menu Bar" : The GP menu bar contains menus that list specific tasks that can be completed. You can click on the menu bar item to see its selections, or you can press <Alt> plus <F> to see the File menu. Once you click <Alt> plus <F>, notice that your menu bar selections have an underlined letter. If your menu bar selections have an underlined letter that means you can make a selection by typing <Alt> and the underlined letter. For example, in Windows XP if you press the <Alt> key then press the <F> key, the menu bar shows underlined letters as well as the submenu. You can also click with your left-mouse button on the menu bar headings to see the submenu selections. 

(
The Toolbar XE "Toolbar"  appears below the menu bar. To see the toolbar defaults, click Views, Toolbars. The toolbars with a check mark next to them are selected. Observe that your login name (sa) is shown as well as the company name, Fabrikam, Inc.; and the date for the sample company’s transactions, 4/12/2007. Scroll over some of the toolbar icons to see what they represent. The Toolbar is also customizable.
(
Minimize [image: image7.bmp], Double Window [image: image8.bmp], or Maximize [image: image9.bmp], and Close or Exit [image: image10.bmp] buttons:  Clicking once on Minimize [image: image11.bmp] reduces the window to a button on the taskbar.  In Windows, the [image: image12.png]44 start ]



 button and taskbar are located at the bottom of your window. Clicking once on Double Window [image: image13.bmp] returns the window to its previous size. This button appears when you maximize the window. After clicking on the Double Window [image: image14.bmp] button, the symbol changes to the Maximize [image: image15.bmp] button. Click once on the Maximize [image: image16.bmp] button to enlarge the window.  Click once on the Exit or Close [image: image17.bmp] button to close the window, or exit the program.

(
Navigation Pane XE "Navigation Pane" 
:  Great Plains offers a graphical alternative to the menu bar. 
[image: image62.png]Tools  Transactio

SmantList
Shartcuts »
Reminders

Task List

Financial Lists
Sales Lists
Purchasing Lists
Inventory Lists
HR & Payrol Lists

Toabars »
+ Navigation Pane.



(
Series buttons XE "Series buttons" : Some of the functions of the program are represented by series buttons. If you click on one of the series buttons, Financial, Sales, or Purchasing; a list shows above it. For example, click [image: image18.png]) Financial



. Notice that the Financial Lists includes links to Accounts, Accounts Transactions, and Checkbooks.
TYPICAL GREAT PLAINS WINDOWS XE "TYPICAL GREAT PLAINS WINDOWS"  

When a menu bar selection is made, a window displays. You can enter information into that window by using the mouse to click on icons or by typing.
The window illustration on the next page is the Transaction Entry window (click Transactions; Financial, General).  There are four sections on this window:  ( the icon bar, ( the lookup field (magnifying-glass icon), 

( Expansion; ( Link; ( Browse; ( Drop-down list (down arrow); and question mark ([image: image19.bmp]) for Help. 
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(
Icon bar XE "Icon bar" : The icon bar shows pictures of commands or additional   information that pertains to the window.  Some icons are common to all windows while other icons are specific to a particular window.  

[image: image20.png]o save




Saves the changes you’ve made in this window.  Transactions entered in batches can be saved and posted later.


[image: image21.png]ete.



 
Deletes the transaction.


[image: image22.png]%o Vaid




Voids the currently displayed saved transaction.


[image: image23.png]4z Post





Posts the transaction. You can post 365 days prior to the first day of the oldest open year at any time using a single-user batch, or transaction-level posting method if you marked Allows Posting to History in the General Ledger Setup window (Tools; Setup; Financial, General Ledger).


[image: image24.png]4 Corect




Opens the Correct Journal Entry window where you can back out, or back out and correct a posted transaction.


[image: image25.png]) Com




Opens the Copy Journal Entry window where you can copy a posted transaction.
· Lookup XE "Lookup" :  The most common field used is called the lookup field.  A magnifying-glass icon indicates lookup fields. In a lookup field, you can select from a list of records. With your cursor in the lookup field, you can also press <Ctrl>+L to see the lookup list.
(
Expansion: The expansion button opens a window where additional information for the field can be added, changed or viewed. 
· Link: Words that are underlined and shown in blue font indicate a link. Click on the Account link to view more information.
(
[image: image26.png]44>



  Browse: You can go to the previous record, next record, first or last record by clicking on one of the arrows. Click the left arrow for the previous record; or the right arrow for the next record. You can also go to the first record and last record.
(
Drop-Down List XE "Drop-Down List" : The down arrow means that this field contains a list of information from which you can make a selection.  Many of GP's windows have drop-down lists that appear when you click on a down arrow next to a field.  

?
The question mark is shown on most windows. You can click on the question mark or press the function key <F1> to open the Help window.

If the Transaction Entry window is open, click [image: image27.bmp] on its title bar to close it.
NAVIGATION PANE XE "NAVIGATION PANE" 
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You can use the Navigation Pane XE "Navigation Pane"  to move around GP without using the menu bar or toolbar.
Shortcut bar: The shortcut bar contains
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the default shortcuts. 
List pane XE "List pane" : When you choose a Series

Button, lists are displayed in the list pane.

When you select an item from the list pane, a list

window opens that allows you to complete

actions.

Series buttons XE "Series buttons" : Choose a series button to display

the lists associated with that series in the list pane.

The default series buttons are Financial, Sales,

Purchasing, Shortcuts.
The table that follows lists the series

Button that are available in the Navigation

Pane and the lists associated with them.
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	Series buttons XE "Series buttons" 
	Lists

	Financial
	Accounts, assets, checkbooks, and account transactions.

	Sales
	Customers, prospects, salespeople, sales, sales order, receivables, and invoicing transactions.

	Purchasing
	[image: image77.png]= (2 Microsoft Business Solutions
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Vendors, purchasing, payable, and purchase order transactions.

	HR & Payroll

Lists
	Employees, applicants, payroll, and attendance transactions.

	Manufacturing

Lists
	Manufacturing orders, Manufacturing bill number, job costing, picking documents, and primary routines.

	Project Lists
	Projects, timesheets, and billing transactions.


USER PREFERENCES XE "USER PREFERENCES" 
Before you change user preferences, let’s make sure that Show Required Fields is selected.
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To make sure Required Fields is selected, select Help. 

2. Observe that one of the selections is Show Required Fields. There should be a checkmark next to it. If no checkmark is shown, click Required Fields to place a checkmark there.) 

3. If necessary, select <Esc> to close the Help menu.

Follow these steps to change the User Preferences.
1. On the shortcut bar, click [image: image28.png]I User Preferences



.

2. The User Preferences window appears.
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Let’s review the information on this window. You can use the User Preferences window to modify your individual preferences. These preferences are saved on a per user basis.

4. In the Options area, click on the box next to Horizontal Scroll Arrows to place a check mark in it.

5. In the Default Destination area, click Screen. This will allow your reports to be printed to the screen for display purposes.

6. Accept the default for Tab in the Entry Key area. This means that you should use the <Tab> key to move between fields on entry windows. If you would prefer to use the Return <Enter> key, make that selection.

7. Accept the default for Quote in the Default Sales Doc. Type area.

8. Accept Local as the default in the Distributed Processes area.
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9. Click [image: image29.png]


. The User Display Preferences window appears. In the Required Fields area, select Red as the Font Color. Once red is selected as the font color, this will change all GP companies. In other words, this is a global change.
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The User Display Preferences window includes selections to change how GP looks on your computer. Various colors and styles are available for links and required fields.

10. Make sure the Required Fields, Font Color is red, then click   [image: image30.png]


 to return to the User Preferences window. 

11. Click [image: image31.png]


 to return to the menu bar. 

12. To see the red font color for required fields, do this. From the menu bar, select Transactions; Purchasing, Transaction Entry to open the Payables Transaction Entry window. Observe that the fields that need to be completed are shown in red. Close the Payables Transaction Entry window by clicking [image: image32.bmp]. 

DISPLAYING PRODUCT INFORMATION XE "DISPLAYING PRODUCT INFORMATION" 
1.
From the menu bar, click on Help, then About Microsoft Business
 
Solutions–Great Plains. The About Great Plains window appears. 
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2. After reviewing the window, click [image: image33.png]


 to close it.
USING WINDOWS EXPLORER XE "USING WINDOWS EXPLORER" 
The instructions that follow show you how to identify GP’s program path, directories, and subdirectories on the hard drive of your computer. You  also see the size of the GP and sample company data.

Follow these steps to use Windows Explorer to identify GP’s location on your computer system.

1. If necessary, minimize Great Plains. Your Windows desktop should be displayed.
2. If your desktop has a Windows Explorer icon, double-click on it. Or, click [image: image34.png]iJstart



; All Programs, Accessories, Windows Explorer. (These instructions are consistent with Windows XP. If you are using another version of Windows, make the appropriate selections. For example, you may need to click, Start; Settings, Accessories, Windows Explorer.)
3. In the Address field, select drive C, then double-click on the Program Files folder to open it. The address field shows C:\Program Files. Now double-click on the Microsoft Business Solutions folder to open it. A Great Plains-Education folder is shown; open it. The Address field shows C:\Program Files\Microsoft Business Solutions\Great Plains-Education. This is the location (program path) of Great Plains on your computer.
4. Notice on the left side of your window, there is a Folders list and that the Great Plains folder has a plus sign next to it.
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5. Right-click on the Great Plains-Education folder. A drop-down list appears. Left-click on Properties. The Great Plains Properties window appears. Compare your window to the one shown on the next page.

Observe the location (program path) of Great Plains is C:\Program Files\Microsoft Business Solutions. The size of the file is 261 MB or 274,574,966 bytes and contains 267 files and 8 folders. Your file size, number of files, and folders may differ. 
6. Click [image: image35.png]


.  This takes you to C:\Program Files\Microsoft Business Solutions. Observe that there are three folders: Great Plains-Education; My Companies, and Projects.
7. Close Windows Explorer.
MENU BAR XE "MENU BAR"  
GP's menu bar has 11 selections:  File, Edit, View, Tools, Transactions, Inquiry, Reports, Cards, Extras, Windows, Help. 
1. Enlarge Great Plains. (Hint: Click [image: image36.png]Microsoft Business Solutions-
&S



 on the taskbar.) From the menu bar, click File to see the file menu options. The file menu includes commands to switch User and Company, User Date, and Maintenance procedures such as checking links for tables. Backup, Restore, Process Monitor, Print, and Exit are also included.


Menu choices that are followed by an ellipsis are associated with dialog boxes XE "dialog boxes"  or windows that supply information about the open window.  An arrow (►) next to a menu item (for example, Maintenance) indicates that there is a submenu with additional selections.  Also, observe that pressing <Ctrl>+<P> can be used to print.
From the menu bar, click Edit. The edit menu includes commands to undo, cut, copy, paste, clear, select all, insert and delete rows within a window. Observe that keyboard shortcuts such as <Ctrl>+ <X> can be used to Cut, as <Ctrl>+<C> to copy, etc.

2. From the menu bar, click View.  The View menu allows you to view Smartlists, Shortcuts, Reminders, Task List, Financial Lists, Sales Lists, Purchasing Lists, Inventory Lists, HR & Payroll Lists, Toolbars and the Navigation Pane XE "Navigation Pane" . Observe that when an arrow is next to an item, then mean that more choices are available.
 
3. From the menu bar, click Tools. Tools such as Setup, Utilities, Routines, Customize, Integrate, Macro, and Resource Descriptions are available.
Observe that each selection has an arrow next to it. This indicates that additional submenu choices are available.

4. From the menu bar, click Transactions. Transactions includes access to Financial, Sales, Purchasing, Inventory, Payroll, Human Resources, and Fixed Assets.

5. Click on Inquiry to see its menu. Choices for System, Financial, Sales, Purchasing, Inventory, Payroll, Human Resources, and Fixed Assets are available. The Inquiry menu lists windows that you can open to view existing information.


6. Click Reports.  Reports provides access to windows where you can create System, Company, Financial, Sales, Purchasing, Inventory, Payroll, Customized, Combined Group, Human Resources and Fixed Assets reports. You can also access the Letter Writing assistant.


7. Click Cards. This selection provides access to cards, which are used to enter master records for System, Financial, Sales, Purchasing, Inventory, Payroll, Human Resources, and Fixed Assets.

8. Depending on what window you are working in, Extras contains options for changing the information that’s shown. The options available in the Extras menu depend on the window you are working in and the field in which the cursor is located. In the example below, the Sales Transaction Entry window is open.


9. In order to see the Windows selections shown below, open the Sales Transaction Entry window (click Transactions; Sales, Sales Transaction Entry). The Windows menu lists all windows that are currently open. You can use this menu to move between windows; the window you select from the menu becomes the active window.

10. Click Help. The Help menu provides Help on Contents, Index, About This Window (the function key <F1> allows you to open context-sensitive help from an opened window), Show Required Fields, Printable Manuals, Documentation on the Web, etc. 

.


ADDING INFORMATION TO THE COMPANY NAME XE "ADDING INFORMATION TO THE COMPANY NAME" 
Let’s add your name to Fabrikam, Inc. Then, load and unload data and review newly added information. Follow these steps to do that.

1. From the menu bar, select Tools; Setup, Company, Company. The Company Setup window appears.

2. Add your name to Fabrikam, Inc. in the Name field. The Company Setup window below shows Frabrikam, Inc.-Student’s Name in the Name field. Your instructor may prefer that you change other fields; for example, change the Contact field to your name; change the company’s address, city and state to yours.


3. Click [image: image37.png]


 to return to the menu bar. Now that you have added some data, continue with the next section to learn about loading and unloading data.

LOADING AND UNLOADING GP DATA XE "LOADING AND UNLOADING GP DATA" 
Each time you add data to a company, the DYNAMICS.mdf file is updated. If you are working in both the computer lab and off-site with a standalone computer,
 copy the hard drive folder containing the 12 files shown on page 27, step 3, to a network location or external media. When you want to return to the computer lab, reverse the process. 

Two files identify Fabrikam, Inc.—TWO.mdf and TWOLog.ldg. These files are called the database ID. The extension .mdf is an abbreviation of master data file. The extension .ldf is an abbreviation of log data file. Along with the database IDs, there are also two DYNAMICS files. The DYNAMICS.mdf and DYNAMICSLog.ldf files accumulate the company data in Chapters 1-14. Each time you exit GP and unload data, the DYANAMICS.mdf file is updated. Step 3 on page 27 shows the files in the My Companies folder. Refer to the chart on page xiv to see the files associated with each company.
The flowchart below shows the choices you have when you exit GP.



Think of the load/unload process as attaching and detaching data. When you exit GP and select Yes to unload data, you are detaching data. When detached data is copied to a hard drive location, then GP is started and data is loaded, you are attaching data. For example, the window prompts you to load data. You browse to the hard drive location of the attached files and select the DYNAMICS.mdf file. This procedure allows you to start at that point in the data. 
If you are working off campus on a standalone computer (for example, your own laptop or PC), periodically load and unload data. This will ensure that you have data to continue work. That is illustrated on the “Maybe” choice on the flowchart, page 25.
In a computer lab, you will probably need to load (attach) data because individual companies will not be listed when you start GP. If the company is not listed, then you must load data from a hard drive location.
Copying Data from My Companies to Student Data
The authors suggest that you set up a hard drive folder to store company data. The steps below show you how to copy data from the My Companies folder to a newly created Student Data folder. You must exit Great Plains and unload data before copying files from one folder to another folder. 
1. Exit GP. When the window appears asking Do you want to unload your data?, click [image: image38.png]


. 

When Yes is selected, you are detaching data and updating the DYNAMICS.mdf file. To see this, go to Windows Explorer, open the C:\Program Files\Microsoft Business Solutions\My Companies folder. Observe the Date Modified column shows the current date and time. (Hint: If necessary, from the Windows Explorer menu bar, select View; Details.) 

2. In Windows Explorer, set up a new hard drive folder called Student Data. The authors recommend that students use their first and last name. The textbook refers to this folder as Student Data.
3. Copy the 12 files from the My Companies folder to the Student Data folder. The files in the My Companies folder are shown below.

4. Close Windows Explorer. Now let’s see what happens when you start GP.
Starting Great Plains
1. Start GP. Type your password. Click [image: image39.bmp]. The Microsoft Business Solutions-Great Plains window appears.


2. This window is telling you that there isn’t any data loaded. This means you need to attach data. Click [image: image40.png]


. 

3. Browse to the location of your data; for example, C:\Program Files\Microsoft Business Solutions\Student Data. (The Student Data folder is used as an example. Your data may be in a different hard drive location). Open the DYNAMICS.mdf file.

4. Wait for the Company Login window to appear. Select Fabrikam, Inc. Click [image: image41.png]


 two times.

5. Check to see if your changes are there. 

Tools: Setup; Company, Company. Your Name should be at the end of the Name field.

Transactions; Purchasing; Transaction Entry. The required fields should be shown in red.

You have now detached (unloaded) and attached (loaded) data. This is the procedure you use when you want to start where you left off the last time you used GP. 
Making a Zip File XE "Making a Zip File" 
When you copied the files in the My Company folder to the Student Data folder, observe that the files are large (see step 3, page 27). In order to make files smaller, zip them. When you zip the Student Data folder, it will compress or make the files smaller. Compressed folders are identified by the zipper on the folder icon. 
Follow these steps to zip the Student Data folder.

1. Exit Great Plains. Unload data. (Click “Yes” to the question, Do you want to unload data.) 

When copying GP data, you must exit GP and unload data. In the steps that follow you are going to zip a file, then copy the smaller file to external media.

2. Go to Windows Explorer. Browse to the location of the Student Data folder.
3. Right-click on the Student Data folder. To see how large the file is left-click, Properties. Observe that the folder is 909 MB. Close the Student Data Properties window. 

4. Right-click on the Student Data; left-click Send To.


5. Left-click on Compressed (zipped) Folder. When the files are zipped, you have a folder with a zipper on it.

6. Observe that the Student Data.zip folder is 137,062 KB (or 137 MB). 
7. Copy the zipped folder to external media. 
Extracting a Zip File
1. To extract the zipped files, browse to the location of the Student Data.zip folder. Double click on it. The Student Data.zip window appears.

2. Select Extract all files. The Extraction Wizard appears. Click [image: image42.png]Next >



.

3. Browse to a hard drive location where you want to place the extracted files. If you do that, the files will be on the hard drive when you load Great Plains data. 
4. Select [image: image43.png]Next >



 and the files begin to extract.

5. When the Extraction Complete window appears, click [image: image44.png]


. Observe that the file size is the same as that shown on page 27. For example, DYNAMICS.mdf is 61,440 KB.
6. Close all windows to return to the desktop. 

You may need to transport your data from one location to another. The flowchart below shows this task.


GREAT PLAINS HELP XE "GREAT PLAINS HELP" 
Great Plains includes a couple levels of Help. In the instructions that follow, you look at GP’s Using Help file, and pressing <F1> for context-sensitive help.
1. Start GP. Load data. If necessary, browse to the location of your Student Data folder. Open the DYNAMICS.mdf file. In the Company field, select Fabrikam, Inc.


2. From the menu bar, click Help, Contents. Make sure the Contents tab is selected. 
3. Click on the plus sign next to Great Plains® Help; then click Using Help.

4. Read the information on the right side of the window. If necessary, click [image: image45.bmp] to enlarge the window. 

On the left pane (under the tabs), make a few other selections to look at the Help windows. When through close the Help window.
5. Another way to use the GP’s Help is to press the function key, <F1>, or click [image: image46.bmp] at the bottom of most windows. For example, click Transactions; Financial, General. The Transaction Entry window appears. 
6. The Transaction Entry window appears. Press <F1>.
7. Observe that the Help window’s left pane has Transaction Entry window selected. The right pane has numerous links.

8. Select Fields. The Transaction Entry window: Fields information appears. Each field on the Transaction Entry window is explained.

9. Link to a few other areas. Links are identified by blue, underlined words. 

10. When you are through navigating the Help windows, exit the Help windows. 
11. Close all windows. (Hint: From the menu bar, click Windows, Close All. 
COMPLETING CHAPTER 1
In this textbook, the folder used to load and unload data is called Student Data. You may have used your name to identify this folder. 
	
Read me:  Create a Chapter 1 Folder

Periodically copy data to external media. For instance, create a Chapter 1 folder. Then, exit GP and unload data. Copy the files from the Student Data folder to the Chapter 1 folder. Then zip the Chapter 1 folder and copy it to external media.

To resume work, copy the zipped folder to a hard drive location. Extract the files. Start GP, click “Yes” to loading data, browse to the location of the Chapter 1 folder, open the DYNAMICS.mdf file. On the Company Login window, select Fabrikam, Inc.


1. Before exiting GP, review the information in the Read me box. Select File; Exit. 
2. If you are going to copy files, select “Yes” to unloading data. If working on your own computer, select “No” to unloading data. 
	INTERNET ACTIVITY XE "INTERNET ACTIVITY" 

	The Internet XE "Internet"  is a worldwide electronic communication network that allows for the sharing of information. The World Wide Web XE "World Wide Web"  (WWW) or Web is a way of accessing information over the Internet. To read about the differences between the Internet and the Web, go online to www.webopedia.com/DidYouKnow/Internet/2002/Web_vs_Internet.asp.To make an Internet connection, your computer must be equipped with a modem. The word modem is an abbreviation of Modulator/Demodulator. A modem is a device that translates the digital signals from your computer into analog signals that can travel over telephone lines. There are also DSL (digital subscriber lines) modems, cable modems, and T-1 lines for faster connections.

	1.
	Go to your Internet XE "Internet"  Browser. Then go online to www.microsoft.com/BusinessSolutions/GreatPlains. The Microsoft Business Solutions−Great Plains web site appears.

	2.
	Select two links from this page. Using a word processing program, write an essay about each site you selected. Remember to include the web site address of each link. Your summary for each site selected should be no more than 100 words or less than 75 words.

	3.
	From your Internet XE "Internet"  browser, go to the textbook’s web site at www.mhhe.com/yachtgreatplains. Link to the Student Edition.        

	4.
	Link to Internet XE "Internet"  Activities, then Part 1 Internet Activities for Chapters 1-6

	5.
	Complete the New Accountant web exercise for Chapter 1, New Accountant.


SUMMARY AND REVIEW XE "SUMMARY AND REVIEW" 
SOFTWARE OBJECTIVES XE "SOFTWARE OBJECTIVES" :  In Chapter 1, you used the software to:

1. Start Great Plains 8.0 (GP).

2. Explore the sample company, Fabrikam, Inc.
3. Set user preferences.
4. Operate Great Plains’s drop-down lists, lookup fields, toolbar, navigation pane, and menus.

5. Identify GP’s program path with Windows Explorer.
6. Unload or detach data.

7. Load or attach data.

8. Copy Fabrikam files.

9. Zip Fabrikam files.

10. Navigate the Help system.

WEB OBJECTIVES XE "WEB OBJECTIVES" :  In Chapter 1, you completed these Internet XE "Internet"  activities:

1. Went online to Great Plains’s web site at www.microsoft.com/BusinessSolutions/GreatPlains.

2. Used your Internet XE "Internet"  browser to go to the book’s web site at www.mhhe.com/yachtgreatplains.
3. Completed Internet XE "Internet"  Activities.
GOING TO THE NET XE "GOING TO THE NET" 
	Comment
The textbook web site at www.mhhe.com/yachtgreatplains has a link to Textbook Updates. Check this link for updated Going to the Net exercises.


Access the Career Development web site at

www.net-temps.com/careerdev/index.htm?type=careertalk&channel=fin&topic=careers
Read the article Careers in Accounting & Finance.
1. What three skills are essential for those seeking careers in accounting and finance?

2. What is the preferred educational background for an accountant?

3. List five career opportunities in accounting and finance.

FLASH CARD REVIEW
To review how to use Great Plains, create flash cards. For example, for installing GP, write Installation on one side of the card; on the other side, write the steps for software installation. Create flash cards for the following.

1. Software installation.

2. Installing company data.

3. Uninstalling GP.

4. Starting GP and loading Fabrikam, Inc.

5. Setting user preferences for showing required fields.

6. Exiting GP and unloading (detaching) data.

7. Copying and transporting data between computers.

8. Zipping (compressing) and unzipping (extracting) folders or files.

9. Using Windows Explorer to determine file size.

True/Make True XE "True/Make True" :  Write the word True in the space provided if the statement is true.  If the statement is not true, write the correct answer.

1.
If there is an underlined letter in the menu or option you want to select, hold down the <Alt> key and the underlined letter to make the selection.



_______________________________________________________


_______________________________________________________

2.
The menu items that have an arrow next to them indicate that there is another submenu with additional selections. 


_______________________________________________________


_______________________________________________________

3.
Shortcut keys XE "Shortcut keys"  enable you to use Great Plains’s mouse.




_______________________________________________________


_______________________________________________________

4.
In this book, the greater and lesser signs are used to indicate individual keys on the keyboard; for example <Tab>.




_______________________________________________________


_______________________________________________________

5.
You can close the application you are working with if you single click with your mouse on the close button ([image: image47.bmp]).


_______________________________________________________


_______________________________________________________

6.
You can hide the Navigation Pane XE "Navigation Pane"  by unchecking that option on the View menu.


_______________________________________________________


_______________________________________________________


7.
You can set preferences to use the <Tab> key or <Enter> key to move between fields on GP’s windows.

_______________________________________________________


_______________________________________________________

8.
The Navigation Pane XE "Navigation Pane"  is shown at the top of your window.


_______________________________________________________


_______________________________________________________


9.
In a lookup field, you can use <Ctrl>+<U> to see the list associated with the lookup field.

_______________________________________________________


_______________________________________________________

10.
Compressing or making a file smaller is called extraction. 

______________________________________________________


______________________________________________________

Exercise 1-1 XE "Exercise 1-1" :  Follow the instructions below to complete Exercise 1-1:

1. Start Windows, then GP. Start Fabrikam, Inc. If data needs to be loaded go to step 2.
2. If necessary load data. (Hint: Browse to the Student Data folder on the hard drive. Open the DYNAMICS.mdf file. Start Fabrikam, Inc.)

3. Check the following information:

a. User Preferences: Horizontal Scroll Arrows; Screen; Tab, and Local should be selected.

b. Click Display: Required Fields shows the Font Color is red. Close windows.

c. Tools; Setup, Company, Company. Your name should be after Fabrikam, Inc. in the Name field.

d. Close all windows.

4. Continue with Exercise 1-2 XE "Exercise 1-2" .

Exercise 1-2 XE "Exercise 1-2" 
1. Exit Great Plains. 
2. If you are working in the computer lab, unload data then copy to a hard-drive location, network share drive, or external media. For detailed steps, see Loading and Unloading GP Data, pages 24-27. (Hint: If working on your own computer (i.e. laptop), select [image: image48.png]


 when Great Plains asks if you want to unload data.)

3. If necessary, zip the files to compress them. (Hint: Refer to pages 28 and 29, Making a Zip File XE "Making a Zip File" .) 
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	�If Great Plains 8.0 is not installed see Software Installation, pages iii to xv.  The My Companies folder must be installed to a hard drive location, page viii.


	�Refer to the chart on page 2 for file sizes. 


	�The greater and lesser signs are used around words to indicate individual keys on your keyboard; for example, <Alt> is for the Alternate key, <Enter> for the Enter/Return key, <Ctrl> is for the Control key, <Esc> is for the Escape key.


	�These instructions assume that Great Plains Standard 8.0 English Education (CD1) and the Sample Data (CD2) have been installed. (See pages iii-xv.) 


	�If the Navigation Pane� XE "Navigation Pane" � is not displayed, from the menu bar, select View. Click on Navigation Pane to place a check mark next to it. There is also a Navigation Pane icon (�) on the Toolbar� XE "Toolbar" �. Clicking � displays or hides the Navigation Pane.


	�A standalone computer refers to your own personal computer; for example, a laptop. 
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